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Microsoft PowerPoint makes it easy to create presentations that are both visually appealing and accessible!  This 
Faculty Guide will introduce you to many of the built-in tools that Microsoft PowerPoint has to offer and teach 
you the best practices to keep in mind when creating new presentations or editing existing ones to be more 
accessible.  The guide begins with an overview of the Accessibility Checker in PowerPoint and how it can be used 
to improve the overall accessibility of your presentations for display on the web or in your online course.  It will 
then take a closer look at common accessibility pitfalls and the steps you can take up front as you create new 
presentations in the future. 

MICROSOFT POWERPOINT ACCESSIBILITY CHECKER 

Microsoft PowerPoint has a built-in tool to scan a document for accessibility issues.  Using the tool, you can see 
which elements of your presentation need attention and receive 
guidance in fixing the items it found. 

To check a presentation for accessibility, first open the document 
in Microsoft PowerPoint. 

1. Click on the “File” menu in the upper left of the window, 
then click on the “Check for Issues” button.  A drop-down 
menu will appear from which you will select “Check 
Accessibility”  

2. The Accessibility Checker panel will open on the right side 
of the screen.  As you can see from the screenshot on the 
next page, several issues with the example presentation 
were identified. 

The issues found in the example file include: 

• Missing Alt Text for an image and table 

• No Header Row specified for the table 

• Missing Slide Titles 

• Unclear Hyperlink Text 

• Blank Table Rows or Columns 

There are other issues with the presentation that require a manual check such as color contrast and 
reading order.  We will be looking at what these issues mean and how to format your presentation to 
make it accessible from the start in the remainder of this guide. 
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Inspection results are divided into three categories: 

Errors: Content that makes the presentation difficult or impossible to read and understand for people 
with disabilities 

Warnings: Content that in most (but not all) cases makes the presentation difficult to understand for 
people with disabilities 

Tips: Content that people with disabilities can understand but that could be presented in a different way 
to improve the user’s experience 

Note:  To quickly see the area of the presentation where PowerPoint found an issue, click on it in the Accessibility 
Checker and the location in the presentation will become highlighted! 

Also pay attention to the “Why Fix:” area of the Accessibility Checker.  It explains why that item is a concern for 
the purposes of accessibility.  

http://www.sunybroome.edu/online
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We will now take a look at common issues found by the Microsoft PowerPoint Accessibility Checker and will 
begin with those involving the Slide Theme and Layout.  We will then move on to Images (Alt Text), tables, 
hyperlinks, and reading order.  The guide will conclude with additional tips and best practices for formatting 
slides and design considerations with accessibility in mind. 

PRESENTATION THEME AND SLIDE LAYOUT 

Presentation Theme 
Using one of PowerPoint’s built-in themes (templates) is the first step in creating a PowerPoint 
presentation that is accessible on the web. The Design tab in PowerPoint provides access to many built-in 
themes to choose from. When choosing a theme for a presentation that will be available on the web or 
within an online course, be sure to choose a theme with good color contrast and simple backgrounds. 

To apply a theme to a presentation: 

1. Click on the “Design” tab within PowerPoint.   

2. Select the Theme that you would like to use. 

3. For many of the built-in Themes, you can also choose a different color in the “Variants” portion of 
the toolbar ribbon.  The theme and color variant will be applied to the entire presentation. 

Slide Layout 
Properly using PowerPoint’s Slide Layouts is the most important step in creating an accessible PowerPoint.  
Using a built-in layout will ensure that the slides are presented properly to a screen reader and will contain 
the correct heading structure and reading order it needs to accurately convey the information in the 
presentation.  For example, most slide layouts contain a field for a slide “Title” appearing at the top of the 
slide. They also contain place holder areas where you can add other content, such as bulleted lists, charts, 
images, etc.  Using these pre-formatted fields on a slide will assist the screen reader in determining the 
importance and the order of the items on the slide.  If items are added manually without the use of the 
slide layout, it will read the items in the order that they were added to the slide, which may not be the 
logical Reading Order for the information you are trying to present. 

It is best to use the preset slide layouts from the beginning, when you first start out creating your 
PowerPoint presentation, but if you are working with a presentation with no layout it can be fixed.  You will 
just need to apply a layout to each slide and then cut and paste each of the manually entered content items 
into the appropriate place holder.  The Accessibility Checker in PowerPoint will display issues with the 
layout of your slides in the “Tips” section of the Inspection Results pane, under “Check Reading Order.” 
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To fix slides that do not have a preset layout: 

1. Click on the slide for which you would like to apply the Slide Layout (or select it from the 
Accessibility Checker Inspection Results Pane). 

 

2. From the Home TabSelect the “Home” Tab and 
click on the drop-down arrow next to the “New Slide” 
button.  This will bring up the listing of preset layouts 
to choose from.  Choose the preset layout that is 
appropriate for the content on your slide. 
 
Note:  Do not simply click the “New Slide” button 
witout selecting a preset layout or the new slide will 
be unfomatted just like the one that precedes it!  If 
you accidentally do this, you will need to change the 
slide’s layout before adding content to it. 

3. You will now see the preset layout and its place 
holders added to the new slide.  You will now 
need to return to the original slide, select the text 
or other item, and select copy. 
 
Note:  When copying text from one slide to 
another, be sure to only copy the text that 
appears within the frame, not the box surrounding 
the text as well. 
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4. Return to the new slide and right-click within the place 
holder that is appropriate for your content.  Select “Use 
Destination Theme” under the Paste Options.  If done 
correctly, the layout styles will apply automatically (Ex: 
bullets).  You will need to repeat this process for each 
content item on the original slide.  

5. You may also need to make other slight modifications to the 
text on the slide, particularly in getting the bullets to appear 
in the proper hierarchal order. 

6. When you are finished, you should see two slides with 
the same content listed in the pane on the left side of 
the screen.  You can now delete the one that did not 
use the proper layout by right-clicking on it and 
selecting Delete Slide. 

7. Repeat the entire process until all slides in the 
presentation are using preset layouts and there are no 
additional messages regarding Reading Order in the 
Accessibility Checker window. 

ALTERNATIVE TEXT FOR IMAGES, TABLES AND OTHER VISUAL ITEMS 

Images and Tables are used extensively in presentations and within online courses.  While they are often very 
beneficial and necessary to convey information, they can also be a barrier to those with a disability when not 
used or formatted in an accessible manner.  

Alternative text (Alt Text) is text contained within the settings of an 
image or table that describes its appearance or function to those 
who are unable to see it.  A screen reader for a visually impaired 
user will read the alternative text to them out loud so that they 
have a better understanding of its content.  Microsoft PowerPoint 
makes it easy to add alternative text to images, tables, shapes, 
SmartArt, and charts.  To do this: 

1. Right Click on the image and select “Format Picture” (or if 
it is a Table, you would right-click and select “Format 
Shape”)  
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2. The Task Pane will appear on the right side of the PowerPoint menu.  From 
it, select the option for “Size & Properties”  

3. Expand the area for “Alt Text” and enter text 
that describes the image in the Description 
field.  The Alt Text should be descriptive, 
specific, and should provide context.  Use the 
Title area to give the image a very brief 
description. 

4. When finished, click the “X” in the upper right 
corner to close the Format Picture Task Pane 

TABLES 

The use of tables should be limited to organize data that have logical relationships in grids.  When they are used, 
they need to be marked up properly for accessibility.  In addition to having associated Alt Text (as we saw 
above), tables must also not contain any blank rows or columns and must have a Header Row specified so that 
they are accessible.  To specify the Header Row:  

1. Make sure that your table 
contains labels text in the first 
row that would be appropriate 
for a header.  If it does not, insert 
a row at the top of the table and 
type in appropriate labels. 

2. With the table selected, click on 
the Design Tab under the Table 
Tools area in the menu at the top 
of the PowerPoint window. 

Note:  When a table is selected, PowerPoint will display two Design Tabs.  For our purposes here, we want 
the one toward the right, under “Table Tools.” 

3. Click “Header Row” on the left of the ribbon to designate the first row of the table as a Header Row.  
The look of the first row will change slightly as it is now specified as the Header Row. 
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HYPERLINKS 

For individuals who use assistive technology, links within presentations should convey clear information about 
the destination.  Rather than displaying the URL as the hyperlink text or linking through text labeled “click here,” 
you should include descriptive text around the link to explain its destination. 

Example of an inaccessible link: 
“For more information click here.” 

Example of a more accessible version: 
For more information on web accessibility, visit the Online@SUNY Broome webpage.  (if the document is 
meant to be posted online) 

Or 
For more information on web accessibility, visit the Online@SUNY Broome webpage at 
http://www.sunybroome.edu/online. (if the document is meant to be printed) 

Or 
For more information on web accessibility, visit the Online@SUNY Broome webpage 
(http://www.sunybroome.edu/online).  (for a combination of web viewing and print) 

To add or edit a hyperlink on a presentation slide: 

1. Type the text which will contain the hyperlink 
and select the text that will become the 
portion that links to the website.  

2. Right-click on the selected text and select 
“Hyperlink…” 

3. You should see the text that you have 
selected in the “Text to display:” field.  In the 
“Address:” field, type (or paste from the web) 
the address of the website you would like to 
link to. 

4. When finished, click the 
OK button. 
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ADDITIONAL TIPS AND BEST PRACTICES FOR ACCESSIBILITY 

In addition to the guidelines we have discussed so far, there are several other best practices you should keep in 
mind when creating or editing a document in Microsoft PowerPoint. 

Bullets and Numbered Lists 
Bulleted and numbered lists should be used not only to organize information into meaningful chunks or 
present sequencing so that they can be easily scanned by sighted users, they also provide the hierarchy and 
coding necessary for assistive technologies to interpret properly.  When creating bullets or numbered lists 
in Microsoft PowerPoint always use the built-in functionality (through the Slide Layout).  Never create lists 
manually by simply typing numbers, characters, images or other symbols before list items. 

You should also always avoid putting too much text on a single slide.  Bullet points should contain just 
enough information to get the point across in a logical way without overwhelming the person viewing the 
presentation.  This rule applies for the benefit of all, not just for those with disabilities! 

Transitions and Animations 
Slide Transitions and Animations on slides should be simple.  Not only can complex transitions and 
animations become distracting, they may also cause errors in assistive technology that cause slides to 
repeat or not advance properly.  Automatic slide transition may not give a user enough time to read and 
process the content contained on the slide. 

Audio and Video 
Transcripts must be provided for all embedded audio and videos included on slides must be captioned. 

Structure and Consistency 
Keeping the slides within your presentation consistent will make them more accessible to everyone.  Using 
the same style and common layouts will not only improve the flow of the presentation, but will also 
facilitate navigation and comprehension for individuals with cognitive disabilities or those who require the 
use of assistive technologies. 

Font Formatting 
Font Typeface and Size 
Stick to simple, sans-serif fonts that are at least 24 points in size for bullets and content text.  Titles should 
be at least 40 pts.  Arial, Helvetica, Tahoma, and Verdana are good choices, particularly for content 
that will be displayed on the web.  They are all examples of sans-serif font, a grouping of typeface that does 
not have small decorative lines as part of the characters.  Times New Roman is an example of a serif font.  
Notice the added decorative shapes that form the letters.  These shapes (serifs) can make the text appear 
more crowded and less readable to individuals with certain disabilities such as dyslexia. 

Flashing or Blinking Text 
Content that flashes or blinks on the screen should be avoided as it can trigger seizures in susceptible 
individuals.  It can also be very distracting for those with cognitive disabilities and also for those with no 
disability at all. 

Use of Color 
When formatting text in a presentation, there are a few guidelines to keep in mind with respect to the use 
of color.  Below are the several of the most common design tips for creating accessible text and using color. 

• Never use color alone to show emphasis – Individuals with color blindness, low-vision, or those who 
are simply viewing your content in black and white or in bright sunlight, would have difficulty 
distinguishing emphasis of information if color is its only cue.  If you would like to use color for 
emphasis, be sure to pair it with another formatting option, such as bold, italics, or text size.  In 
charts and graphs, color should be paired with a pattern. 

• Make sure your foreground and background have strong contrast between them – Web 
Accessibility Guidelines require specific contrast ratios based on the size of the text.  If you are 
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unsure whether your particular choice of colors fall within these ratios, you can visit the WebAim 
color contrast checker (https://webaim.org/resources/contrastchecker/).  Also pay particular 
attention to text that is overlaid on a background image, as some or all of the image may not have 
sufficient contrast in relation to the text. 

• Avoid certain color combinations – In addition to contrast, there are certain color combinations that 
should be avoided whenever possible.  These include: green/red, green/brown, blue/purple, 
green/blue, light-green/yellow, blue/grey, green/grey, green/black.  Individuals with color blindness 
are often unable to distinguish between these color pairs, particularly green and red. 

• Avoid using color for coding – We’ve all seen this done, particularly in email.  (“Please see my 
answers typed in purple…”).  Formatting text this way in a document, particularly one that will be 
viewed on a webpage, presents a challenge to those with colorblindness or a visual impairment that 
relies on a screen reader.  As screen readers do not allow for a way to search on text color, another 
form of emphasis should be used in addition to the color (such as italics). 

SUMMARY 

Applying a few basic guidelines will make your content more accessible to all learners.  In conclusion, we have 
made all of the changes suggested in this document and re-ran the Microsoft PowerPoint Accessibility Checker.  
As you can see No accessibility issues are now found, so it is good to go! 

Online@SUNYBroome 

Please visit the Online@SUNYBroome website (www.sunybroome.edu/online) for additional information 
pertaining to distance education.  The site contains information for Students, Faculty and Chairs.  A repository of 
informational/instructional documentation is included on the site as well as a listing of training opportunities 
and frequently asked questions. 
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